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Introduction 
Attribute tables for the DLG thematic layers for Indian Town (boundaries, hypsography, 
hydrography and transportation will be edited and additional attribute information entered into 
the database. Create a lab6attrib folder for this work.  BE SURE TO CREATE A .mxd file early 
on and save your work after each step as ArcMap is known to frequently hang-up during this 
exercise. 
 
Joining Tables 
In lab 2 you joined tables to the hypsography and hydrography coverages. If that linkage has 
been lost you will need to redo it.  You should also join the appropriate attribute tables to the 
roads and boundary coverages. Refer to the lab 2 handout and your flowchart for instructions if 
needed. The important thing to remember is that “Joins” are NOT permanent- the linking of 
multiple tables is only temporary and, if not saved in the .mxd, is lost when ArcMap is shut 
down. 
 
Making Joins Permanent 
To make a “Join” permanent, the Arc Coverage with the Joined Table(s) must be converted to a 
shapefile. This is considered an Export function. Right-click on the layer for the drop down 
menu, click Data, then Export Data. Export all the DLG coverages to shapefiles and place 
them in the lab6attrib folder.  To assure a common naming convention use the following names 
for the shapefiles:  roads, boundpoly, boundarc, contours, hypsopoly and hypsoarc. If you have 
already exported some of the DLG data to shapefiles, use ArcCatalog to rename them to the 
specified naming convention. 
 
Edit Attribute Tables Beginning with the Roads Polyline Shapefile 
Begin editing with the roads shapefile.  Open the attribute table (Right-click on layer name > 
Open Attribute Table).  Notice within the table there are a lot of empty columns (fields) 
containing information we do not want. To delete unwanted fields:  right-click on the unwanted 
field name and click Delete Field/Yes. 
 
 NOTE: deleting a field is permanent. 
 
Delete the following fields: Rowid_,  MODN_ID_1; ARBITRARY_; RELATION_T;  
VERTICAL_R OPERATIONA;  ACCESS_RES; WITH_RAILR;  COVERED;  HISTORICAL; 



LIMITED_AC;  PHOTOREVIS;  BEST_ESTIM; and  FUNCTIONAL.  DO NOT DELETE 
THE OLD_RAILROAD Field. If you delete this field by accident, go back to the coverage and 
export it again. 
 
To add a new field, Click the Options button at the bottom of the table window, and then click 
Add Field. Create a new field labeled “DLG_Code” and make it a short integer. The DLG_Code 
field will consist of the last three digits from the entity label column. For example, if the entity 
label is 1700211, you will enter 211 under the DLG_code column. 
 
The most efficient way to enter data into multiple records is to use the query builder (Options > 
Select by Attributes) and build a SQL (sequential query language) expression to select all 
entity_labels with the same value. 
  
Once the appropriate records are selected, use the field calculator (right-click on DLG_Code > 
Field Calculator), to add the last three digits into the appropriate record, click OK.  Repeat for 
all unique entity label values. 
 
In the lab 6 folder on the P:drive/FW3540 is a .pdf file of the DLG codes. Add a field called 
“Description” (text, width 35) to the attribute table.  Translate the DLG_Code to Descriptive 
names in the text field. Be sure to check your spelling (misspellings are treated like separate 
attributes, i.e. deciduous and decidous are not the same attribute as far as ArcMap is concerned). 
Remember- text added to the Field Calculator must be enclosed with double quotes. 
 
Every DLG coverage or shapefile will have boundary lines designating the edge of the Indian 
Town quad. For those thematic layers which are polylines, delete the boundary arcs. Be sure you 
are not deleting road arcs. This is best done by selecting the boundary arcs in the viewer and then 
deleting the associated record selected in the attribute table.  You must be in edit mode to delete 
data. Save your edits (Editor Menu > Save Edits, then select Stop Editing). 
 
Why would you not want to delete boundary line segments in a polygon thematic layer?  
 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
If there are road segments with no associated DLG code, overlay the roads on the orthophotos, 
interpret the road type from the photo and fill in the attribute table accordingly. Editing is 
complete when there no empty cells in the DLG-Code and Description fields, and there are no 
misspellings of the descriptive names. 
 
Create a detailed roads legend in the Table of Contents and rename the codes with the actual 
road descriptions.   
 
The road segment length computed automatically by ArcMap is based on the linear distance 
units of the projected coordinate system, which in this case are meters. Having a field, which 



expresses the length in miles, would be more useful. Add a field labeled “MILES” using a float 
designation. 
   
Calculate the miles for each road segment, in the new MILES field, by using the field calculator 
and building an expression (HINT: miles = LENGTH field / conversion factor). What is the 
conversion factor from meters to miles? _______________ 

 
Total road mileage can be determined by opening the attribute table, going to Select by 
Attributes and query a specific road class, then right-click on the MILES column heading and 
select statistics. This gives the sum and other statistics of ONLY the selected rows. How many 
miles are there of each road class? _________________________________________________ 
 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
 
Editing Attributes of Hydrography Polygon Shapefile 
You should already have a completed the table join and created a shapefile in lab 2 for the 
hydrography polygon coverage.  If not, you need to join the table (.ahyf) and export it to a 
shapefile.  The hydrography layer, when displayed as polygons, and joined with the supporting 
tables, makes the distinction for water classes by entity label 
 
Add a new field (Options > Add Field) to the table labeled “DLG_code” and add the last three 
digits from the entity label column to the DLG_code column, as in the roads layer above.  Use 
the query builder (Options > Select by Attributes) and Field Calculator to quickly and 
accurately fill in the field values. 
 
 In the lab 6 folder on the P:drive/FW3540 is a .pdf file of the DLG codes. Add a field called 
“Description” (text, width 35) to the attribute table.  Translate the DLG_Code to Descriptive 
names in the text field. Be sure to check your spelling. Remember- text added to the Field 
Calculator must be enclosed with double quotes. 
 
NOTE: you can not be in edit mode to add or delete a field. 
 
Develop an appropriate legend in the symbology using the DLG Description. Be sure to use the 
USGS wetlands symbol for the wetlands, and an appropriate blue for the lakes. “USFS green” is 
suggested for the upland areas, which has an entity label value of zero. 
 
Add two more new fields to the hydrography polygon layer, Acres and Hectares.  Perform the 
appropriate calculations with the Field Calculator to convert square meters to acres and 
hectares.  Answer the following: 
 

1. How many acres of lakes are found within the Indian Town Quadrangle? __________ 
 
2. What is the size, in acres, of the smallest lake (sort the acres column)? __________ 



 
3. What is the size, in hectares, of the largest lake (sort the hectares column)? 

_________ 
 
Editing the Hydrography Polylines Shapefile 
Use the same procedure as utilized for editing the hydrography polygon shapefile. 
 
Editing Attributes of the Boundary Polygon and Arc Shapefiles 
The challenge with the boundary file is trying to figure out who owns what.  You will need to 
evaluate several fields including entity labels, civil_town, national_f and city. Decide if you can 
accomplish this just using the legend editor or would it be best to create an additional field with 
ownership combinations?  You may also want to view the Digital Raster Graphic (DRG) located 
in the lab6 folder in a DLG folder on the P: drive. It will display as a .tif files and ia literally a 
scanned images at 300 DPI of the quad sheets for the western half of Alger County.   
 
Repeat the process for the Boundary Arc file as well. 
 
Creating a Cartographically Correct Map 
How to make map outputs and display data in an informative way is a critical component of GIS. 
We will be working this week with the layout view of ArcMap and will be going over the 
different map elements that separate a map from a textbook illustration. You will be creating a 
map of your land use/cover shapefile. The map is not yet finalized, but the evaluation of interim 
maps is very common. 
  
Humans associate certain colors with various features. For example, blue for water and green for 
trees. Hence, it is important to take the time to develop a meaningful color scheme that matches 
the data you are working with. This is true for all types of data, but especially for land use/cover 
classes. A good technique for selecting colors is simply to think about the colors you associate 
with different land cover types and use those colors, look at several map examples or easiet of all 
use the same colors used by the USGS- the color .pdf file is on the class website. Develop a 
meaningful color scheme for your land use/cover using a combination of colors and symbols. For 
this map, the wetlands will only be displayed in 2 classes- emergent wetlands and woody 
wetlands 
 
Display the Data 
Open a new window in ArcMap and add the following layers: hillshade, roads and your land 
use/cover file. Right click on your land use/cover file and go to Properties/ Display/ 
Transparency. Change the 0 in transparency to 50. Click OK. Display the land use/cover over 
the hillshade and the roads on top of the land use/cover. This will create a pseudo 3D display. 
Change the symbol of the roads to either a black or red line. For this map the roads are providing 
locational or place holder information only. Think back to our discussion in lecture about place 
holder information. 
 
Adding Labels 
Open the attribute table for the land use/cover file. You have a field of land use/cover 
descriptions and will display those on the map. We do this by going to the Labels tab in the 
Layer Properties window (see illustration on the next page).  Check the box “label features in 



this layer”, leave the method as “label all the features the same way, and make sure “NAME” or 
whatever you labeled  

 
 
the descriptive field,  is in the label field. Change the font to Arial Black and the font size to 10. 
Click OK. You will see that the labels appear on the top right corner of the symbols.  
 
We can control where the labels appear. Go back to the Labels tab and click “placement 
properties” (see illustration above). The current label location is shown. By clicking “Change 
Location” we can pick another label location. On the Bottom of the intial point placement 
window you see 0=Blocked, 1=Highest, 3=Lowest. These are label weights used only when 
there is a conflict, that is, an overlap between a label and a feature. For more information on 
labels, search for them in the help section of ArcMap.  
 
Working with the Layout View 
Click on the layout view icon at the bottom of the display. See location circled in red on 
illustration on the next page. 
 
You will notice that the map layout that you are familiar with is still there but is displayed 
differently. First step  is change the layout view from portrait to landscape.  Go to 
File>Page and Print Setup. In the paper section of the page and print setup window 
check the box next to landscape and click OK. The layout view changes from portrait to 
landscape, but the layer box does not. Resize the layer box by clicking on a corner and dragging 



it. You will find that you still have the same tools in layout view as you had in data view.  See 
illustration on next page. 

 
 
Adding Elements of a Map 
There are several key elements to a map: 

Scale Bar 
North Arrow 
Legend 
Title 
Text description 
Context 
Neatline 
Most of these elements can be added using Insert from the main menu. 



 
 
Title 
Go to Insert on the top Menu Bar and select Title. A text box appears in your layout view. Click 
outside the text box and then right click on the text box once. The layout border should turn blue. 
Now right click on the text box and go to Properties. Enter your map title in the text box. Go to 
change symbol and select “Times New Roman” size 20 and change to bold. 
 
Scale Bar 
Go to Insert and select Scale Bar. In the Scale Bar Selector window select the “Alternating 
Scale Bar 2” and click OK. The scale bar will appear in the middle of the layout view. Right 
click it and go to properties. The Scale and Units tab should be shown. Change the division unit 
from meters to miles. Change resizing to “Adjust number of divisions”. You should now be able 
to adjust the division value enter 2 miles and change the number of subdivisions to 3.  
 
Change the label from miles to mi. Click OK. Now insert another scale bar. This time change 
divisions units to kilometers and adjust all other fields the same way you adjusted miles, but 
instead of mi change the label to km. Press ok. You now have two scale bars. one in kilometers 
and one in miles. Adjust the lengths so they show the same number of divisions. Move them 
below the map layer.  
 
North Arrow 
Go to Insert and select North Arrow. Select any north arrow symbol you like. Keep in mind 
your scale bar should reflect the type of text you are using. You should not use a fancy scale bar 
with italics if your map title is Times New Roman. 
 
Legend 
Go to Insert and select Legend. The legend wizard will be launched. In this step you select 
which layers you want to include in our legend. For this map we are only interested in Land 
Use/Cover classes and the roads. Use the direction button to remove the hillshade  gray scale 
from the legend. 
 
Note that a double arrow adds or removes all layers while a single arrow adds or removes a 
single item that is highlighted. Press next. Press next in all the subsequent windows and press 
finish in the end. You now have a legend in your layout view.  
 
Right click on the legend and go to Properties. Click on the items tab. Highlight roads in legend 
items and select style. What appears are the different styles that we can display the layer in the 
legend. Horizontal Single Symbol Layer Name and Description works well for displaying data 
such as points and lines. Select it the aforementioned and click ok. This works well for 
symbolized data because it shows the symbol name as well as the layer name. Select it and press 
ok.  
 
Metadata  Description 
There are five types of metatdata shown as text that are important to include in every map you 
make: Data Source (what agency or agencies supplied us with our data), Coordinate System (the 
projection not of the layers but of the data frame we are using), Description ( a sentence or two 



describing map content), Author (who you are and what you made the map for), and Date (when 
you made the map). These five components insure that we as map makers do not need to be 
present when the map is being utilized in paper or digital format. 
 
Go to Insert and select Text box. Click off of the text box then left click on it and then right 
click properties. This window should look familiar from when we added the map title. You can 
enter the five types of text descriptions in one text box or create a new text box for each. 
Formatting a text box can be tricky; you may need to try several times to get it just right. 
 
What are your data  sources ? _____________________________________________________ 
 
What is your data frame projection?_________________________________________________ 
 
Neatline 
We need  to add a neatline that encompasses all of the map information. Go to Insert Neatline. 
The neatline box is launched. Select the placement, style and color.   
 
 
Due next week- Flow chart explaining how to add and delete fields in an attribute table, 
questions in lab handout, and a map of your interim land use/cover data. 


